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GLOSSARY OF RELEVANT TERMS
The analysis was developed in adherence to the following terms and their definitions adapted from the
U.S. Climate Resilience Toolkit and NFWF.

Term

Definition

Adaptive capacity

The ability of a person or system to adjust to a stressor, take advantage of new
opportunities, or cope with change.

Ecosystem services

Benefits that humans receive from natural systems.

Exposure

The presence of people, assets, and ecosystems in places where they could be
adversely affected by hazards.

Impacts

Effects on natural and human systems that result from hazards. Evaluating
potential impacts is a critical step in assessing vulnerability.

Natural features

Landscape features that are created and evolve over time through the actions
of physical, biological, geologic, and chemical processes operating in nature
(Bridges et al. 2014).

Nature-based features

Features that may mimic characteristics of natural features, but are created by
human design, engineering, and construction to provide specific services such
as coastal risk reduction (Bridges et al. 2014).

Nature-based solutions

Actions to protect, sustainably manage, and restore natural or modified
ecosystems, that address societal challenges effectively and adaptively,
simultaneously providing human well-being and biodiversity benefits (IUCN).

Resilience

The capacity of a community, business, or natural environment to prevent,
withstand, respond to, and recover from a disruption.

Risk

The potential total cost if something of value is damaged or lost, considered
together with the likelihood of that loss occurring. Risk is often evaluated as
the probability of a hazard occurring multiplied by the consequence that would
result if it did happen.

Sensitivity

The degree to which a system, population, or resource is or might be affected
by hazards.

Threat

An event or condition that may cause injury, illness, or death to people or
damage to assets.

Vulnerability

The propensity or predisposition of assets to be adversely affected by hazards.
Vulnerability encompasses exposure, sensitivity, potential impacts, and
adaptive capacity.
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EXECUTIVE SUMMARY
Coastal communities throughout the United States face serious current and future threats from natural
events, and these events are predicted to intensify over the short and long term. Dynamic processes
such as coastal erosion, storm surge flooding, and river runoff exacerbate the threat from sea level rise.
Tropical systems and heavy precipitation events have the potential to devastate both human
communities and fish and wildlife habitats, as has been seen in recent years. As communities prepare,
decision-makers need tools and resources that allow for data-driven decision support to maximize
available funding opportunities and other planning needs.
The Hawaiʻi Coastal Resilience Assessment aims to support effective decision-making to help build
resilience for communities facing flood-related threats. The National Fish and Wildlife Foundation
(NFWF), in partnership with the National Oceanic and Atmospheric Administration (NOAA), is committed
to supporting programs and projects that improve resilience by reducing communities’ vulnerability to
coastal storms, sea level rise, and flooding events through strengthening natural ecosystems and the fish
and wildlife habitat they provide.
This Geographic Information System (GIS)-based Coastal Resilience Assessment combines spatial data
related to land use, protected areas, human community assets, flooding threats, and fish and wildlife
resources in order to identify and prioritize Resilience Hubs (see figure below). Resilience Hubs are large
areas of natural, open space or habitat where, if investments are made in conservation or restoration,
there is potential for improved human community resilience and benefits to fish and wildlife habitats
and species.

iii

The Assessment identified areas throughout Hawaiʻi that are not only exposed to a range of coastalflood related threats, but also contain higher concentrations of community assets. In addition, through
the development of habitat extent and suitability models, the analysis identified terrestrial and
nearshore marine areas with abundant fish and wildlife resources. Together, the Assessment revealed
natural areas of open space and habitat ideal for the implementation of resilience projects that may be
capable of supporting both the people and wildlife of Hawaiʻi. The primary mapping products from the
Hawaiʻi Assessment are shown below.
Local community planners, conservation specialists, and others can use the outputs of the Hawaiʻi
Assessment to help make informed decisions about the potential of restoration, conservation, or
resilience projects to achieve dual benefits for both human and fish and wildlife communities.
This Hawaiʻi Coastal Resilience Assessment report provides a detailed discussion of the data and
methods used for the three analyses (Community Exposure, Fish and Wildlife, and Resilience Hubs),
regional results, and case studies. In addition to the results presented in this report, NFWF has
developed the Coastal Resilience Evaluation and Siting Tool (CREST), an accompanying GIS-based web
tool that allows users to view, download, and interact with the inputs and results of the Hawaiʻi
Assessment (available at resilientcoasts.org).

Community Exposure Index for the Hawaiʻi Coastal Resilience Assessment. Higher values represent areas where a
higher concentration of assets are exposed to flooding threats.
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Fish and Wildlife Index for the Hawaiʻi Coastal Resilience Assessment. Higher values represent areas where numerous
important species and their habitats are located.

Resilience Hubs for the Hawaiʻi Coastal Resilience Assessment. Higher values represent areas where resilience
projects may have the greatest potential to benefit both human communities and wildlife.
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INTRODUCTION
1.1 Hawaiʻi
The Hawaiian Islands are an archipelago in the north Pacific Ocean consisting of eight main islands as
well as over one hundred atolls, islets, and seamounts. They are rich in endemic biodiversity, natural
resources, and cultural heritage. However, communities throughout Hawaiʻi are highly exposed to a
variety of coastal-flood related threats. Hawaiʻi’s dynamic landscape faces numerous natural hazards
ranging from volcanoes, tsunamis, and seismic activity to floods, drought, wildfire, and extreme heat
(Fletcher et al 2002, Hwang & Okimoto 2019).
Local flooding threats range from heavy rains, sea level rise, increased storm activity, and compound
flooding. Compound flooding associated with multiple, simultaneous or sequential heavy rain events
and coastal storms can significantly impact both coastal and inland communities. Hurricane Iniki in 1992
was the last major hurricane to devastate the islands, with particular impacts to Kauaʻi. While only two
hurricanes have made landfall in Hawaiʻi, heavy rain, strong wind, and resulting flooding and erosion
pose considerable threats. For example, in 2018, Hurricane Lane brought record breaking rainfall to the
islands despite never making landfall. One station on the island of Hawaiʻi recorded 58 inches of rain
from Lane (Beven & Wroe 2019). The storm caused one death and approximately $250 million in
damages due to landslides, flooding, and wildfires sparked by downed power lines spread by strong
winds.
The State of Hawaiʻi prioritizes nature-based policy approaches that build resilience. Such efforts
include, but are not limited to, the setback policies, no-hardening regulations, and sea level rise
exposure zones to prevent building in the hazardous coastal zone. Unique to Hawaiʻi, traditional
watershed boundaries from mountains to sea, or mauka to makai, permeate the management
documents for the region, and combine indigenous knowledge within the regulatory framework for a
holistic approach. Hawaiʻi was one of the first states in the nation to adopt a climate adaptation policy in
2012, and has proactively established progressive coastal building setbacks to manage retreat, including
a 2020 law that prohibits shoreline hardening.1 Erosion rates in Hawaiʻi typically average 0.5-1 foot per
year, with some areas experiencing shoreline loss as high as two feet per year (Fletcher et al. 2002).
With 70 percent of Hawaiʻi’s beaches undergoing chronic sand loss and shoreline retreat, and many
miles of beach loss due to hardened structures, this measure reflects Hawaiʻi’s efforts to effectively
address coastal threats.
In addition to climate forward policy actions, numerous efforts have worked to better understand the
threats, needs, gaps, and nature-based approaches that can be applied to help build resilience in
Hawaiʻi. Recent efforts include, but are not limited to Sea Level Rise Vulnerability and Adaptation report
(Hawaiʻi Climate Commission 2017), Guidance for Disaster Recovery Preparedness in Hawaiʻi (Courtney
et al. 2019), Assessing the Feasibility and Implications of Managed Retreat Strategies for Vulnerable
Coastal Areas in Hawaiʻi (Hawaiʻi CZM 2019), Hawaiian Islands Climate Vulnerability and Adaptation
Synthesis (Gregg 2018), the Pacific Islands Regional Climate Assessments (Keener et al. 2012), the State
of Hawaiʻi Hazard Mitigation Plan (Tetra Tech 2018) and the Hawaiʻi Ocean Resources Management Plan
(Hawaiʻi CZM 2020). Such studies are critical to help communities understand, respond to, and prepare
for future storm events. Additional county-level plans and policies govern management of each island.
1

https://mauinow.com/2020/09/17/coastal-zone-management-bill-becomes-law-mitigating-erosion-and-rising-sea-levelthreats/
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These forward-thinking plans, combined with the local governance, hold promise for responding and
implementing effective measures to prepare for future storm events and sea level rise.
As the Hawaiian Islands take steps to lower their exposure and plan for a more resilient future,
resources such as this Coastal Resilience Assessment can equip decision-makers and stakeholders with
valuable tools and information to help them better plan for future flood and storm events. The Hawaiʻi
Coastal Resilience Assessment provides a framework for a holistic approach that considers both
resilience for human communities and fish and wildlife habitat.

1.2 Overview of the Regional Coastal Resilience Assessments
The National Fish and Wildlife Foundation (NFWF) and the National Oceanic and Atmospheric
Administration (NOAA) are committed to supporting programs and projects that improve community
resilience by reducing communities’ vulnerability to coastal storms, sea level rise, and flooding by
strengthening natural ecosystems and the fish and wildlife habitat they provide. In response to growing
coastal flooding threats, NFWF commissioned the University of North Carolina (UNC) Asheville’s
National Environmental Modeling and Analysis Center (NEMAC) to develop an assessment to identify
coastal areas that are ideal for the implementation of nature-based solutions that build both human
community resilience and fish and wildlife habitat. The resulting Regional Coastal Resilience
Assessments (referred to from here forward as the Regional Assessments or Assessments) aim to
identify and rank open space areas and habitat cores where targeted investments can implement
resilience-building projects before devastating events occur and impact surrounding communities.
The Hawaiʻi Coastal Resilience Assessment is part of a broader effort that seeks to evaluate regional
resilience for all U.S. coastlines. Regional Assessments are already complete for the U.S. Atlantic, Gulf of
Mexico, and Pacific coastlines, Puerto Rico, the U.S. Virgin Islands, and the Commonwealth of the
Northern Mariana Islands. Additional Assessments are underway for American Samoa, Guam, Alaska,
and the U.S. Great Lakes (Figure 1).

Figure 1. The geographic extent of the Regional Coastal Resilience Assessments in dark gray and the Hawaiʻi
Assessment in orange. All Regional Assessments will be completed by 2021. Map not shown to scale.
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Strategically implementing resilience projects can increase the ability of surrounding communities and
habitats to withstand and recover from the impacts of coastal storms and flooding events (Narayan et al.
2017). Efforts to build resilience begin by determining the exposure of a community’s assets to a hazard
or threat. The Regional Assessments use a GIS-based approach to model landscape characteristics and
their potential impacts to identify places throughout the United States where assets are potentially
exposed to flood threats. They combine human community assets, flooding threats, and fish and wildlife
resource spatial data to identify and rank Resilience Hubs. Resilience Hubs are large areas of natural,
open space or habitat where, if investments are made in conservation or restoration, there is potential
for improved human community resilience and benefits to fish and wildlife habitats and species.
From a modeling standpoint, the Regional Assessments consist of three separate but interrelated
analyses: (1) the Community Exposure Index, (2) the Fish and Wildlife Index, and (3) the Resilience Hubs
(Figure 2). These three components make these Assessments unique as they look at resilience potential
through the lens of both human and fish and wildlife communities. Specifically, the Community
Exposure Index can guide land use and hazard mitigation planners in identifying potential development
constraints and improve the understanding of potential risks to critical infrastructure and human
populations. The Fish and Wildlife Index can inform where on the landscape important species and
habitats occur. The Resilience Hubs then identify open spaces and habitat suitable for the
implementation of projects expected to build communities’ resilience to flood events while also
benefiting fish and wildlife.

Figure 2. A conceptual model showing the separate, but interrelated components of the
Regional Coastal Resilience Assessments.

While the Resilience Hubs are the primary output of the Regional Assessments, each component can be
used individually or in combination to help community planners, conservation specialists, funding
applicants, and others make informed decisions about the ability of potential restoration, conservation,
or resilience projects to achieve dual benefits for both human community resilience and fish and wildlife
species and habitats.
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METHODS
2.1 Introduction
The foundation of the Regional Coastal Resilience Assessments is based on the coastal vulnerability
research outlined in Gornitz et al. (1994). In 2011, the New Jersey Office of Coastal Management and
Department of Environmental Protection adapted that research to assess existing and future hazard
vulnerabilities on a local scale (NJ-DEP 2011). This research was integral to structuring the inputs and
methodology of this analysis.
The following sections provide a brief overview of the methods used in the Hawaiʻi Coastal Resilience
Assessment. For more details about overarching methodology and data sources common across all
Regional Coastal Resilience Assessments, please refer to Dobson et al. (2020). To the extent possible,
the Regional Assessments aim to use the same methodology and data across all regions. However, given
the unique geographic characteristics of each region and the fact that data availability varies, some
regionally-specific modifications were required. Additionally, given the geographic scale of Hawaiʻi, the
Advisory Committee recommended that all GIS modeling be completed at a 10-meter resolution to best
match the resolution common to the input data. The following sections briefly discuss pertinent
methodological changes to the Community Exposure Index, Fish and Wildlife Index, and Resilience Hubs
for Hawaiʻi.

2.2 Study Area
The Hawaiʻi Assessment focuses on the main islands of Hawaiʻi, Maui, Kahoʻolawe, Lānaʻi, Molokaʻi,
Oʻahu, Kauaʻi, and Niʻihau, and does not include the Northwest Hawaiian Islands. Hawaiʻi has a total
population of nearly 1.4 million people, though the population of each of the main Hawaiian Islands
varies widely, from the most populous island of Oʻahu with over 950,000 people to Niʻihau with just 170
residents. The island of Kahoʻolawe is uninhabited. With just under 1,300 kilometers of coastline, the
main islands possess a startling diversity of ecosystems, climates, terrain, and habitats ranging from
volcanic craters to coral reefs.
The Assessment covers the entire watershed, from mauka to makai, or from the mountains to sea,
extending into the ocean to the 30-meter depth contour (Figure 3). As described below, the 30-meter
depth boundary was used for the Fish and Wildlife Index to allow for the inclusion of the marine habitats
with potential to host significant biodiversity. Based on the recommendation of technical experts,
however, the Resilience Hub analysis only considered habitats less than 10 meters in depth since
shallow water habitats are expected to provide greater coastal protection benefits through the
implementation of nature-based solutions.
This Assessment is unique in that it not only considers the immediate coastline, as many other studies
have done, but it also focuses on inland areas that can often directly contribute to coastal flood-related
issues. For instance, intense rain and riverine flooding that then drains directly to the coast can
exacerbate coastal flooding. In all regions, the boundary of the Assessments follow the coastal
watersheds designated by the U.S. Environmental Protection Agency (EPA), which are watersheds that
drain directly to the ocean and are represented at a hydrologic unit code eight scale (HUC-8)2. For

2

According to the Environmental Protection Agency’s Coastal Wetlands Initiative: https://www.epa.gov/wetlands/coastalwetlands.
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Hawaiʻi, the HUC-8 watersheds cover all the islands, and thus the study area also covers the entirety of
each island (Figure 3).

Figure 3. The Hawaiʻi Coastal Resilience Assessment study area. The 30-meter depth contour is shown in black.

2.3 Data Collection and Stakeholder Engagement
The Project Team compiled an initial set of data from multiple national and regional data sources,
including sea level rise data from NOAA and floodplain data from the Federal Emergency Management
Agency (FEMA). In addition to reviewing publicly available data sources, the Hawaiʻi Assessment relied
on significant input from local and regional stakeholders to identify and inform the use of additional
data sets.
To help guide the Assessment process, the Project Team established an Advisory Committee consisting
of six members representing NOAA, the Hawaiʻi Department of Land and Natural Resources, the Pacific
Regional Integrated Sciences and Assessment, the State Hawaiʻi Office of Planning, University of Hawaiʻi
at Mānoa, and the U.S. Fish and Wildlife Service. The Advisory Committee met regularly with the Project
Team to:
1. Provide guidance to the Project Team at key decision points in the analyses, including
recommendations on data to be included;
2. Help identify additional local stakeholders within federal agencies, local and territorial
governments, universities, non-governmental organizations, and others to provide input into
the development of the Hawaiʻi Assessment; and
3. Advise on final products and tools, including the effective dissemination of results.
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From the Advisory Committee and building on initial data collection, the Project Team hosted a
workshop to allow local stakeholders to review and provide input on preliminary Assessment products.
The Stakeholder Workshop was held on March 10, 2020 in Honolulu as part of an open training session
held in conjunction with the 2020 Pacific Risk Management ʻOhana (PRiMO) Conference.
Over 40 people attended the workshop, representing state, federal, municipal, non-government, and
academic organizations from Oʻahu, Maui, Kauaʻi and Hawaiʻi islands. Workshop participants helped the
Project Team:
1. Identify geographic features, flooding threats, cultural and socio-economic factors, and
additional considerations that are unique to the region;
2. Identify, collect, and appropriately use GIS datasets related to flooding threats, community
assets, and species and habitat;
3. Provide references and contact information for additional experts that may be able to
contribute data or knowledge to the effort; and
4. Obtain overall buy-in to the Assessment process and solicit ways in which it can be used by local
stakeholders in Hawaiʻi.
Participants reviewed draft maps and data sources, providing important feedback and
recommendations to improve the analyses. In addition, participants considered measures that local
communities can take to enhance resilience, including management strategies, activities, and projects
that restore habitats and install natural and nature-based features that reduce flood-related threats.
Following the stakeholder workshop, the Project Team reconvened with the Advisory Committee to
assess the feedback, comments, and suggestions provided during the workshop and to determine which
content and data to incorporate into revised products. NEMAC then followed up individually with
Committee members and other key stakeholders to further discuss data and methodology as needed.
Results of the Hawaiʻi Assessment were reviewed by the Advisory Committee and shared with local
stakeholders via a public webinar.

2.4 Creating the Community Exposure Index
The Community Exposure Index was created by combining the Threat Index and Community Asset Index,
depicting the spatial distribution of the potential exposure of assets to flood threats (Figure 4). The
following equation calculates exposure:
Threat Index × Community Asset Index = Community Exposure Index
To accommodate local datasets and needs, the following text describes the specific methods used for
the Hawaiʻi Assessment. A complete list of datasets included can be found in Appendix A. See Appendix
D for a description of the methodology used to calculate the Community Exposure Index.

6

Threat Index

Community
Asset Index

Flood and Severe
Storm-Related Threats
•
•
•
•
•
•
•

Storm surge scenarios
Sea level rise scenarios
Flood-prone areas
Impermeable soils
Soil erodibility
Areas of low slope
Geologic stressors
• Tsunami inundation

Community
Exposure
Index

Community Assets

X

•
•
•
•

Population density
Social vulnerability
Critical facilities
Critical infrastructure

=

Identifies areas where
community assets are
potentially exposed to
impacts from flooding
or severe storm events

Figure 4. Elements of the Threat and Community Asset Indices used to create the Community Exposure Index.

2.4.1 Threat Index
Flood-related datasets are used to help communities understand what kind of threats are potentially
present in their area. While other threats may exist, for the purposes of this analysis only those threats
relevant to coastal flooding in Hawaiʻi were included. Threats are defined as datasets that show coastal
flood and severe storm hazards on the landscape. The Threat Index is a raster-based model with a
cumulative scoring of inputs (Dobson et al. 2020). As in other Regional Assessments, the Hawaiʻi analysis
included data related to storm surge, sea level rise, flood-prone areas, soil erodibility, impermeable
soils, areas of low slope, landslide susceptibility, and tsunami evacuation areas, each of which are
described in detail in the Methodology and Data Report (Dobson et al. 2020). Additional details on those
data used to create the Threat Index for Hawaiʻi can be found in Appendix A.1 and Appendix B.

2.4.2 Community Asset Index
The Community Asset Index included infrastructure and human population. The Index used datasets
that quantify the number of assets present—not their magnitude of vulnerability or susceptibility to
flood threats. The infrastructure and facilities that were incorporated into the Regional Assessments
were chosen for their ability to help people respond to flood events.
In Hawaiʻi, the Community Asset Index included population density, social vulnerability, and the full
complement of critical facilities and infrastructure detailed in the Methodology and Data Report
(Dobson et al. 2020). It was of utmost importance to include locally available data whenever possible.
Therefore, based on feedback from the stakeholder workshop and Advisory Committee, many local
datasets found on the Hawaiʻi Statewide GIS Program Geospatial Data Portal3 were incorporated. In
addition, the analysis included cultural heritage sensitivity areas and historic sites within the study area.
Although these sites may not directly assist in responding to flood events, their importance to local
communities, as well as any economic value they may hold, were considered justification for including
them as a type of critical infrastructure. The following types of critical infrastructure were included in
the Hawaiʻi Assessment:
3

To view data available through the Hawaiʻi State Office of Planning’s Hawaiʻi Statewide GIS Program, visit
https://geoportal.hawaii.gov/
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●
●
●
●
●
●

Primary roads
Bridges
Airports
Ports
Power Plants & Substations
Petroleum Terminals & Refineries

●
●
●
●
●

Hazardous Sites
Wastewater Treatment Facilities
Railroads/Urban Train
Dams
Cultural & Historic Resources

In addition, as with all other regions, the following list of critical facilities were included because of their
relevance and widespread use following flood events or other disasters:
●
●

Medical facilities (hospitals, nursing homes, etc.)
Law enforcement (police, sheriff stations, etc.)

●
●

Schools (public and private,
universities)
Fire stations

A detailed list of datasets used for all Community Asset Index inputs included in the Hawaiʻi Assessment
can be found in Appendix A.2. See Appendix C for a description of methods used to create the
Community Asset Index.

2.5 Creating the Fish and Wildlife Index
The Fish and Wildlife Index, which consists of Marine and Terrestrial components, allows for a greater
understanding of important habitats and fish and wildlife resources to aid in the identification of areas
where implementing nature-based solutions may support coastal resilience and ecosystem benefits
(Figure 5). The Index attempts to identify areas on the landscape where terrestrial, aquatic, and marine
species and their habitats are located. For the Hawaiʻi Assessment, only those species of concern with
federal- or state-level protection status and/or those included in resource management plans were
considered. By nature, the Fish and Wildlife Index varies regionally; however, a detailed description of
the general methods governing the Fish and Wildlife Index is available in the Methodology and Data
Report (Dobson et al. 2020). Regional considerations for Hawaiʻi are discussed below; a complete list of
data can be found in Appendix A and a description of the methods used to create the Fish and Wildlife
Index can be found in Appendix E.

Terrestrial
Index

Healthy nearshore
marine habitats capable
of supporting significant
biodiversity

Habitat suitability model for
aquatic & terrestrial species of
particular concern for
conservation action
• Species of Concern:
• State Wildlife Action Plan
• Federal- and State-listed
• Habitat
• Important Bird Areas
• National Wetlands Inventory
• Land cover
• Hawaiʻi Association of
Watershed Partnerships
• Other regional data

Fish & Wildlife
Index

Marine Index

+

•
•
•
•
•

Coral reefs
Essential Fish Habitat
Marine Protected Areas
Reef fish biomass
Habitat Areas of Particular
Concern
• Marine managed areas

=

Identifies areas on the
landscape where terrestrial
and marine species and their
habitats are located

Figure 5. Elements of the Terrestrial and Marine Indices used to create the Fish and Wildlife Index.
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2.5.1 Terrestrial Index
The Terrestrial Index aims to identify suitable habitats for major species groups using available land
cover and habitat data. The Index is created relative to the habitat preferences and needs of the species
of greatest conservation concern in the region, which were identified using the 2015 State of Hawaiʻi
State Wildlife Action Plan (Hawaiʻi DLNR 2015) and species listed as threatened or endangered under the
Endangered Species Act. Broad taxonomic and species groupings were used to model habitat
preferences throughout the region, including:
●
●
●
●
●

Forest Birds
Seabirds
Waterbirds
Migratory Birds
Raptors

●
●
●
●

Freshwater Fishes
Reptiles
Terrestrial Mammals4
Invertebrates

Based on habitat preferences associated with each species group, the analysis modeled primary,
secondary, and tertiary habitat suitability (for details see Dobson et al. 2020). A complete list of species
(organized by taxonomic and species group) included in the Hawaiʻi Assessment is available in Appendix
E.1.
In addition to using the NOAA Coastal Change Analysis Program land cover, U.S. Fish and Wildlife
Service’s National Wetlands Inventory, and USGS National Hydrography Dataset to identify habitat
types, the analysis utilized the Carbon Assessment of Hawaiʻi - Land Cover/Biome Unit available through
the Hawaiʻi Statewide GIS Program. BirdLife International Important Bird Areas (IBAs) were also
included, as well as other areas prioritized by local agencies for protection or management such as the
Hawaiʻi Association of Watershed Partnerships and State watershed priority areas. A complete list of
datasets and methods used to create the Hawaiʻi Terrestrial Index can be found in Appendix A.3 and
Appendix E.1, respectively.

2.5.2 Marine Index
The Marine Index aims to identify marine habitat types that can support significant biodiversity, such as
coral reefs. While other marine habitat types may support significant biodiversity, the Hawaiʻi
Assessment focused on those habitat types where restoration and resilience projects may offer the
multiple benefits of species richness, ecosystem enhancement, and coastal protection.
Benthic habitat maps, extending to a 30-meter depth bathymetry contour around all islands, were used
to define the spatial extent of coral reef habitat. To assess coral condition, estimates of live coral cover
were obtained from NOAA’s National Coral Reef Monitoring Program, which regularly implements
stratified random sample surveys throughout the islands. Based on surveys from 2019, areas with higher
coral cover—and thus more likely to support higher numbers of reef associated species (Komyakova et
al. 2013)—were ranked higher. Due to ecosystem changes since the benthic habitats were mapped in
2007, it was recommended that the survey data be used at the sector-level broken into three depth
categories, known as the strata-level, using bathymetry (Tom Oliver, NOAA, personal communication).
The coral cover data were pooled for each strata and then ranked across the islands. The three depth
levels are as follows: shallow (0-6 meters), mid-depth (>6-18 meters), and deep (>18-30 meters).
In addition to the spatial extent and condition of these habitat types, the Marine Index calls upon a
number of additional datasets including managed areas such as NOAA Habitat Areas of Particular
4

The Hawaiian hoary bat (Lasiurus cinereus semotus) is the only native terrestrial mammal in Hawaiʻi.
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Concern (HAPC), Essential Fish Habitat (EFH), the Hawaiian Islands Humpback Whale National Marine
Sanctuary, Marine Protected Areas, designated critical habitat for the Hawaiian monk seal, and marine
managed areas. Several Fisheries Management Plans designate EFH in Hawaiʻi, including pink snapper,
sea bass, and giant trevally. A complete list of datasets and methods used to create the Hawaiʻi Marine
Index can be found in Appendix A.4 and Appendix E.2.

2.6 Creating the Resilience Hubs
Resilience Hubs are areas of natural, undeveloped space that attempt to identify places that may be
suitable for resilience-building conservation or restoration efforts that can help prepare for potential,
adverse impacts to infrastructure and communities, while also improving the habitats of fish and wildlife
species. Therefore, Resilience Hubs represent open spaces and habitats that have a high potential to
provide benefits to both human communities and fish and wildlife. Accounting for natural spaces on
both inland areas and in the nearshore marine environment, Resilience Hubs are formed based upon
undeveloped landscapes and habitat types to create two outputs: Green Habitat Cores (inland) and Blue
Habitat Cores (marine)(Figure 6).
Blue Infrastructure
analysis produces:

Green Infrastructure
analysis produces:

Green
Habitat Cores

Blue
Habitat Cores

Areas of intact habitat cores
capable of supporting
freshwater and terrestrial
communities

Nearshore marine areas
capable of supporting
coastal habitats

●
●
●
●
●
●
●

Underdeveloped land cover
Soil characteristics
National Wetland Inventory
Topographic diversity
Compactness ratio
National Hydrography Dataset
Roads, buildings, and railroads
as fragmenting features

Cores are then scored by the
average Fish & Wildlife and
Community Exposure Indices

&

●
●
●
●
●
●

Live coral cover
Coastal wetlands presence
Coral reef crest presence
Beach/dune presence
Within 10-m bathymetric depth
Within 1.5-km distance from
wetlands, coral reefs and reef
crests, and/or beach/dunes

Resilience
Hubs

=

Habitat Core areas that
have the potential to
provide benefits to both
human communities and
fish and wildlife, ranked by
scores calculated in the
combined Blue and Green
Habitat Cores

Cores are then scored by the
average Fish & Wildlife and
Community Exposure Indices

Figure 6. Elements of the Green and Blue Habitat Core outputs used to create the Resilience Hubs.

While the criteria differ between the Green and Blue Habitat Cores, both models rank Resilience Hubs
according to the combined average values of the Community Exposure Index and the Fish and Wildlife
Index (for a detailed description of methods see Dobson et al. 2020). To show variation within Resilience
Hubs, the Habitat Cores are further subdivided and scored at a finer 4-hectare (10-acre) hexagon grid
(Figures 7, 8, and 9). This scale was chosen to facilitate local decision-making commensurate with the
size of potential nature-based projects and solutions.
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Figure 7. An initial step in creating the Green and Blue Habitat Cores. Note the Green Habitat
Cores include both terrestrial and freshwater aquatic areas. The Blue Habitat data include coral
cover, beach and dune, tidally influenced wetlands, coral reef crests, and nearshore marine areas
less than 10 meters in depth but have not yet been grouped into Cores.

Figure 8. Green and Blue Habitat Cores converted to 4-hectare (10-acre) hexagons. As with each
Habitat Core, each hexagon is later ranked to show variation within Resilience Hubs.
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Figure 9. Final Green and Blue Habitat Cores. The Blue Habitat hexagons are grouped into Habitat
Cores by bathymetric basin. The resulting Green and Blue Cores are then ranked to become
Resilience Hubs.

2.6.1 Green Infrastructure
The Green Infrastructure5 analysis used in the Regional Assessments builds upon methodology
developed by the Green Infrastructure Center for the continental United States (Firehock & Walker
2019). Since these data were not available for Hawaiʻi, NEMAC replicated the analysis to create this
important layer for the Hawaiʻi Assessment. The analysis identifies “intact habitat cores,” or every
natural area 40.5 hectares (100 acres) or greater, regardless of ownership or preservation status. The
dataset is intended to guide local, regional, and urban planners in identifying important places to
conserve prior to planning development projects. The dataset also helps to prioritize which landscapes
to protect and connect—such as natural systems that mitigate flooding, provide recreational
opportunities, and benefit air and water quality (Firehock & Walker 2019). Habitat cores also represent
relatively intact habitat that is of a sufficient size to support more than one individual of a species and
considers fragmenting features that may disrupt the movement of wildlife species.
Applying these methods to Hawaiʻi, the Green Infrastructure analysis resulted in the creation of Green
Habitat Cores, or inland habitat cores encompassing both terrestrial and aquatic habitats. The resulting
Green Habitat Core features are then converted into a 4-hectare (10-acre) hexagonal grid (Figure 8). The
hexagonal grid helps to highlight variation in the Community Exposure Index and Fish and Wildlife Index
scores associated with each habitat core to help facilitate fine-scale decision-making. For full
documentation on how the Green Habitat Cores were created, please refer to Dobson et al. (2020).

5

Note that Green Infrastructure analysis—as it is referred to in this Assessment—pertains to a specific methodology and is not
intended to represent other local planning and management projects.
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In summary, the Green Infrastructure approach—in determining both Green Habitat Cores and their
subsequent hexagons—identifies contiguous natural landscapes composed of similar landscape
characteristics. Lands identified have the potential to be of higher ecological integrity and thus may offer
improved potential for both human and wildlife benefit. This allows for a more accurate determination
of the boundaries of natural landscapes when forming and ranking the Resilience Hubs. See Appendix
A.5 and Appendix F for more details.

2.6.2 Blue Infrastructure
Recognizing the prominence of valuable coastal marine habitats in Hawaiʻi, the Assessment developed a
Blue Infrastructure6 analysis. Marine and coastal habitats, such as coral reefs, wetlands, and beach and
dune systems not only support significant biodiversity but are also important natural features that can
protect human communities and infrastructure from flooding-related threats. Unlike the methodology
used in the Green Infrastructure analysis, marine environments typically lack the fragmenting features
that are necessary to delineate and form open spaces into inland habitat cores. As a result, the Project
Team developed a different approach to identify Blue Habitat Cores, or marine and coastal areas
represented by habitats that may be suitable for the implementation of conservation or nature-based
resilience projects. The Blue Habitat Cores were delineated by creating a 4-hectare (10-acre) hexagonal
grid of all coastal and marine habitats less than 10 meter in depth and then by grouping hexagons
according to the Hawaiʻi bathymetric basins and the marine habitats they contain. Unlike the Fish and
Wildlife Index, only habitats less than or equal to 10 meters in depth were considered in the Blue
Infrastructure analysis since nature-based solutions are more likely to provide coastal protection when
implemented in shallow water habitats. For full documentation on how the Blue Habitat Cores were
created, please refer to Appendix F and Dobson et al. (2020).

2.6.3 Combining Habitat Cores and Ranking Resilience Hubs
To capture the potential impact the Green and Blue Habitat Cores may have on reducing the effects of
coastal flooding on nearby community assets while also benefiting fish and wildlife, the Habitat Cores
were scored using the average values of the Community Exposure and Fish and Wildlife Indices to
determine the rankings of Resilience Hubs. After ranking, the lowest 10 percent of ranked cores were
removed. For details about how Green and Blue Habitat Cores were scored, see Dobson et al. (2020). As
noted above, every habitat core feature was converted into a finer-resolution 4-hectare (10-acre)
hexagonal grid. As a result, each hexagon also received its own individual ranking, allowing for a finerscale view of areas within any given Habitat Core. When considered in combination with the Resilience
Hubs, the hexagons can help identify areas that may be ideal for resilience-building efforts that achieve
dual human community and fish and wildlife benefits. See Appendix A.5 and Appendix F for more
details.

6

Note that Blue Infrastructure analysis—as it is referred to in this Assessment—pertains to a specific methodology and is not
intended to represent other local planning and management projects.
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RESULTS
The Hawaiʻi Coastal Resilience Assessment reveals abundant opportunities to use nature-based
solutions to help build human community resilience while supporting fish and wildlife habitat and
species. Nature-based solutions include actions that sustainably manage and utilize natural systems to
address societal challenges such stormwater management, urban flooding, and heat islands while
benefiting biodiversity and human well-being. Implementing nature-based solutions, such as wetland or
coral reef restoration, can provide tremendous co-benefits to people and wildlife as described in the
case studies below (see Section 4).
The Community Exposure Index shows that areas of high exposure are concentrated around dense
urban areas. Along the coastlines of each island, the Fish and Wildlife Index reveals a concentration of
habitat types expected to support wildlife species. As expected, inland areas outside of urban centers
show moderate values that support high concentrations of important habitat for species of concern.
Finally, the Resilience Hubs show that there are numerous Hubs across all islands, both along the
coastline and inland. For the purposes of this report, the results for all islands are described separately;
however, a single model was used for all eight islands, which allows results to be directly compared
within and among islands.

3.1 Community Exposure Index
The Community Exposure Index for the State of Hawaiʻi shows that exposure is mainly concentrated
around the densely populated urban areas along the coast. With an average population density of 220.5
people per square mile and with the vast majority of residents living along the shoreline, it is
unsurprising that low-lying, populated areas are most exposed to flooding threats. Throughout the state,
the highest exposure values were associated with the most populous cities, including Hilo, Kahului, and
Honolulu, whereas the lowest exposure values are found on the sparsely populated (or uninhabited)
islands of Niʻihau, Molokaʻi, Lānaʻi, and Kahoʻolawe (Figures 10 and 11). When compared to other
coastal regions of the United States, Hawaiʻi does not contain vast stretches of highly exposed coastline.
In fact, outside of the urban centers, coastal areas around each island exhibit consistently low exposure
values. This is likely due to the topography of the coastline, which not only prevents high concentrations
of community assets from being located directly near the water in many places, but also results in
relatively low values for several flood-related threats.
The Threat Index reveals that flood-related threats affect nearly all coastlines throughout the island
chain. However, cumulatively across all inputs, there are relatively few areas that are highly threatened
by the coastal flood threats. The highest Threat values are seen along the west coast of Kauaʻi, the
southeastern coast of Oʻahu, central Maui, and the northeastern coast of Hawaiʻi Island (Figures 10 and
11). The topography of the islands strongly influences the presence of flood-related threats and their
impacts on the landscape. For example, apart from bays and inlets, the islands feature relatively few
low-lying areas capable of pooling water. In addition, inputs such as sea level rise, storm surge, and
tsunami inundation are all limited to the immediate coastline. Except for impervious surfaces around
densely populated areas, most of the landscape features well- to moderately well-drained soils that help
to minimize flooding risks. Relatively high Threat Index values within the interior portions of the islands
are largely driven by landslide susceptibility and soil erodibility.
While the topography of the region may result in fewer areas of high flooding threat, portions of Hawaiʻi
are densely populated, leaving important community assets exposed to the impacts of flooding. The
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Community Asset Index identifies concentrations of developed, populated areas (Figures 10 and 11);
however, important community assets can be seen throughout the islands, including roads,
communication infrastructure, ports, and airports, all of which are critical for effective emergency
response in the event of major flooding.
At the island-scale, Oʻahu clearly features the highest Community Exposure Values. By focusing on the
city of Honolulu, finer-resolution patterns in exposure become evident (Figure 12). The Threat Index is
mostly driven by storm surge, low lying areas, and the prevalence of impervious surfaces. As expected
for a city of this size, the Community Asset Index is influenced by population density and social
vulnerability, with high concentrations of both critical infrastructure and facilities throughout. Together,
patterns of high exposure are evident throughout southern Oʻahu. Even within the central portions of
the island, near the Schofield Barracks (Figure 11), there are areas of very high exposure due to the
presence of numerous critical facilities and a relatively high population. When combined with low slope,
erodible and impermeable soils, and landslide susceptibility, the Barracks are highly exposed to flooding
threats. To explore the results of the analysis in more detail for any area of interest, visit the Coastal
Resilience Evaluation and Siting Tool (CREST) at resilientcoasts.org. For more details about CREST, please
refer to Section 3.4 below.
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Figure 10. Threat, Community Asset, and Community Exposure Indices for the islands of
Molokaʻi, Lānaʻi, Maui, Kahoʻolawe, and Hawaiʻi. The Threat and Community Asset Indices
are multiplied to produce the Community Exposure Index, which shows areas where assets
overlap flood threats. To view results in detail, see Appendix G or view results in CREST.
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Figure 11. Threat, Community Asset, and Community Exposure Indices for the islands of
Niʻihau, Kauaʻi, and Oʻahu. The Threat and Community Asset Indices are multiplied to
produce the Community Exposure Index, which shows areas where assets overlap flood
threats. To view results in detail, see Appendix G or view results in CREST.
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Figure 12. Honolulu, Oʻahu and surrounding communities show higher values of exposure, resulting from the
combination of flood threats and community assets.
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3.2 Fish and Wildlife Index
The combined Fish and Wildlife Index shows the highest values within productive nearshore marine
waters and biodiverse forests along the islands’ mountain ranges (Figures 13 and 14). Due to the
additive nature of the Fish and Wildlife Index, the highest values are all observed in coastal waters
where healthy marine habitats coincide with terrestrial resources such as seabirds and sea turtles. This
is evident in Hanalei Bay in northern Kauaʻi where there is primary habitat for dark-rumped petrel
(Pterodroma phaeopygia sandwichensis) and green sea turtle (Honu)(Chelonia mydas). In other
instances, high values are driven by overlapping features, such as areas that are designated for
protection or conservation by multiple agencies. This is particularly apparent in the Marine Index. For
instance, and perhaps counterintuitively due to the heavy development in this area, the southeastern
shore of Oʻahu between Māmala Bay and Maunalua Bay receives a moderate-high value in both the
Terrestrial and Marine Indices. The presence of several protected and managed areas, such as
designated critical habitat for the Hawaiian monk seal (Neomonachus schauinslandi), the Hawaiian
Islands Humpback Whale National Marine Sanctuary (HIHWNMS), Essential Fish Habitat (EFH), and
Marine Managed Areas by the Hawaiʻi Division of Aquatic Resources contributes to this high score.
While the highest scoring areas are evident, there are significant fish and wildlife assets throughout all
eight islands, indicating there are ample opportunities for habitat conservation and restoration projects
to sustain Hawaiʻiʻs incredible biodiversity.
As noted in the Methods section, the Terrestrial Index evaluated habitat suitability across species
groups. Due to the proportionally low number of native terrestrial mammals, freshwater fishes,
invertebrates, and reptiles listed in the Hawaiʻi State Wildlife Action Plan (Hawaiʻi DLNR 2015), birds
dominated the Terrestrial Index. Higher concentrations of wildlife assets in the Terrestrial Index along
the coastlines highlight the importance of coastal habitats for migratory birds, sea birds, waterbirds, and
sea turtles (Figures 13 and 14). Forest birds and raptors dominate the interior areas of each island, in
addition to numerous overlapping protected or managed areas. For a complete list of species
referenced for this analysis, see Appendix E.1.
The Marine Index reveals many very high values around each island, highlighting the importance of
marine habitat and species throughout the region (Figures 13 and 14). This is largely driven by the
prevalence of coral reefs and marine managed areas throughout the state. Despite recent bleaching
events, live coral cover was relatively high along large reef tracts in southwestern Maui, eastern Lānaʻi,
and western Hawaiʻi Island. In addition to the presence of corals, these areas also feature EFH for
resource fishes, designated critical habitat for the Hawaiian monk seal, and are located within the
HIHWNMS. Together, these features all indicate these regions harbor significant marine biodiversity.
Some of the highest Marine, Terrestrial, and combined Fish and Wildlife values identified in the Hawaiʻi
Assessment are found along the southern coast of Molokaʻi (Figure 15). Here, high values result from a
combination of marine and coastal habitat used by both marine and terrestrial species. Over 20 miles in
length, the fringing reef off the Southern Molokaʻi shore is the longest and among the healthiest coral
reefs in Hawaiʻi. In addition to very high coral cover, Marine Index values are driven by moderate reef
fish biomass and the presence of EFH, Hawaiian monk seal critical habitat, and the HIHWNMS. This area
also features habitat important to reptiles, sea birds, and migratory birds, contributing to an increased
combined Fish and Wildlife Index score for this region. While many of southern Molokaʻi’s wetlands are
highly degraded by invasive mangroves, they were once home to threatened waterbirds populations
that would likely benefit from habitat restoration efforts in this area. To explore the results of the
analysis in more detail for any area of interest, visit the Coastal Resilience Evaluation and Siting Tool
(CREST) at resilientcoasts.org. For more details about CREST, please refer to Section 3.4 below.
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Figure 13. Terrestrial Index, Marine Index, and the resulting Fish and Wildlife Index for the
islands of Molokaʻi, Lānaʻi, Maui, Kahoʻolawe, and Hawaiʻi. Terrestrial and Marine Indices are
added to produce the Fish and Wildlife Index, which shows concentrations of fish and wildlife
species and their habitats. To view results in detail, see Appendix G or view results in CREST.
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Figure 14. Terrestrial Index, Marine Index, and the resulting Fish and Wildlife Index for the
islands of Niʻihau, Kauaʻi, and Oʻahu. The Terrestrial and Marine Indices are added to
produce the Fish and Wildlife Index, which shows concentrations of fish and wildlife species
and their habitats. To view results in detail, see Appendix G or view results in CREST.
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Figure 15. The southern coast of Molokaʻi, near Kaunakakai, shows higher values in both the Terrestrial and Marine
indices, resulting in medium to high values in the Fish and Wildlife Index. This is a result of a combination of the
presence of several important marine and coastal habitats utilized by marine and terrestrial species.
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3.3 Resilience Hub Analysis
The Hawaiʻi Assessment identified many Resilience Hubs covering much of the state (Figures 16 and 17).
While Oʻahu features many of the highest ranking Resilience Hubs, the assessment revealed ample
opportunities throughout the main Hawaiian islands to implement nature-based solutions to build
human community resilience while benefiting fish and wildlife habitat and the species and ecosystem
services they support.
The final Resilience Hub rankings are the product of the Community Exposure Index and Fish and
Wildlife Index. As described in the Methods section above, the actual boundaries of the Resilience Hubs
are formed through the Green and Blue Infrastructure analysis, which identifies Green and Blue Habitat
Cores. Figures 16 and 17 show the ranked Blue and Green Habitat Cores and how they are combined to
create the final Resilience Hub rankings. Due to the extensive presence of coral reefs and vast tracts of
natural land cover with few fragmenting features, the analysis identified many, large Resilience Hubs.
However, only high-ranking Hubs represent areas with significant potential for nature-based solutions to
achieve benefits for fish and wildlife while also reducing flooding risk to important human community
assets. Therefore, high-ranking hubs in portions of Kauaʻi, Molokaʻi, Maui, Hawaiʻi Island, and
throughout Oʻahu, show the greatest potential for dual benefits and may be best suited for the
implementation of nature-based solutions. In contrast, the less populated (or uninhabited) islands of
Niʻihau, Lānaʻi, and Kahoʻolawe feature few high-ranking Hubs.
On Oʻahu, higher-ranked Resilience Hubs can be found across most of the island, particularly in
Kāneʻohe Bay and within the Koʻolau and Waiʻanae mountain ranges (Figure 16). This is due in part to
the extensive presence of coral reef and wetland habitats, and the analysis revealed a large network of
Blue Habitat Cores encompassing nearly the entire nearshore marine boundary (<10-meter depth). Blue
Habitat Cores found in nearshore areas also received a higher score if multiple habitat types are present
in the same areas (within 1.5 kilometers). Areas with multiple habitat types in close proximity may offer
opportunities to implement a suite of coordinated nature-based solutions to maximize the potential to
protect surrounding coastal communities from storm and flood events (see the Case Study in Section 4).
High ranking Green Habitat Cores are also found along the relatively undeveloped mountain ranges,
where highly endangered native forest birds and invertebrates remain. While the Community Exposure
Index revealed relatively low exposure along the mountain ridges, high ranking Hubs are still visible. This
is in part driven by high Fish and Wildlife values but is also the result of large tracts of contiguous open
space where at least a portion of nearly any given Resilience Hub is in close proximity to community
assets threatened by flooding.
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Figure 16. Green Habitat Cores, Blue Habitat Cores, and Resilience Hubs for the islands of
Molokaʻi, Lānaʻi, Maui, Kahoʻolawe, and Hawaiʻi. To view results in detail, see Appendix G
or view results in CREST.
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Figure 17. Green Habitat Cores, Blue Habitat Cores, and Resilience Hubs for the islands of
Niʻihau, Kauaʻi, and Oʻahu. To view results in detail, see Appendix G or view results in CREST.
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Resilience Hub size also varied considerably between islands, due in part to the large amount of open
and natural land cover found in the interior of most islands (Figures 16 and 17). This is particularly
evident along the coast between Kailua-Kona and Captain Cook on the western coast of Hawaiʻi Island,
where numerous small habitat cores line the shore in contrast to very large, contiguous Green Habitat
Cores further inland (Figure 18). As the waters on the Big Island quickly exceed 10 meters in depth, the
Blue Habitat Cores in this area are relatively small with highly variable ranks. Similarly, small and highly
ranked Green Habitat Cores are concentrated along the coast due to their proximity to community
assets and presence of terrestrial habitat. When the two are combined, the Resilience Hubs highlight
many areas of opportunity for restoration projects. To explore the results of the analysis in more detail
for any area of interest throughout Hawaiʻi, visit the Coastal Resilience Evaluation and Siting Tool
(CREST) at resilientcoasts.org. For more details about CREST, please refer to Section 3.4 below.

Figure 18. The area around Kailua Kona on the western coasts of Hawaiʻi Island shows a range of ranked Resilience
Hub scores. Variability within Resilience Hubs is visible within the 4-hectare (10-acre) hexagons. The inset map for
Blue Habitat Cores further highlights the variability in this area.
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3.4 Coastal Resilience Evaluation and Siting Tool
To provide an online interface to allow users to interact with key Assessment data, including input data
and final models for the Community Exposure Index, Fish and Wildlife Index, and the Resilience Hubs,
the Coastal Resilience Evaluation and Siting Tool (CREST) was developed as an accompanying GIS-based
web tool (available at resilientcoasts.org). CREST helps users make informed decisions about proposed
project sites and address other key questions about how to build resilience within their community. It
also allows users full access to the Hawaiʻi Assessment data so they may incorporate them into their
own GIS applications or other planning processes. For instance, the islands of Oʻahu, Kauaʻi, and Maui
have data related to groundwater recharge, which can be a critical consideration for local resilience
planning; GIS users can incorporate local groundwater data with data from the Assessment downloaded
through CREST into their more specific planning efforts. Additionally, CREST provides access to the
Assessment results even if the user does not have a GIS background or access to GIS software.
Users can directly access results of the Hawaiʻi Assessment straight from the CREST homepage. In
addition to simply exploring the results of the Regional Assessments, CREST allows users to analyze
results for specific areas of interest. For instance, if a user has already identified a potential project
location, they can draw or upload the project boundary within the tool to view site-specific results for
the Resilience Hubs, Community Exposure Index, Fish and Wildlife Index, and the results for each of the
model inputs. Alternatively, if a user does not have a specific project location in mind but is interested in
evaluating opportunities within a particular region, they can draw a broad area of interest to view
results. In both cases, the user can view the results in CREST or download the results in tabular or GIS
formats for additional analysis.
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CASE STUDIES
4.1 Watershed Restoration to Build Resilience
Coastal wetland and coral reef ecosystems provide myriad benefits, from offering coastal protection to
providing habitat for numerous endangered and economically important species. Throughout Hawaiʻi,
coastal wetlands play a critical role in shoreline stabilization and groundwater recharge, while also
reducing the impacts of flooding and polluted runoff. However, extensive development coupled with the
spread of invasive species have greatly reduced the number and condition of wetlands throughout the
Archipelago (Hiromasa Browning 2020). In the most densely populated island of Oʻahu, as many as 65
percent of wetlands have been lost. Of those that remain, more than 75 percent are highly degraded
offering limited ecological function (van Rees 2018). Degraded wetland systems have a reduced ability
to retain stormwater and polluted runoff, which contributes to both flooding and poor water quality. In
turn, poor water quality can compromise the health of nearshore coral reef ecosystems, reducing corals’
ability to provide coastal protection and habitat benefits.
These interdependencies highlight the importance of considering a whole watershed approach that can
utilize multiple natural ecosystems to maximize resilience outcomes. Ongoing efforts in and around
Kāneʻohe Bay on Oʻahu highlight how restoring multiple habitat types can strengthen coastal resilience
for surrounding communities and important wildlife resources. For decades, community-led efforts in
the ahupuaʻa (land division) of Heʻeia have worked mauka to makai to protect the watershed from the
highest ridges to the outer coral reef. With funding from the National Coastal Resilience Fund7 and other
sources, two recent projects are working to restore both coastal wetlands and adjacent coral reefs in
Kāneʻohe Bay. The Nature Conservancy will lead the restoration of 26 acres of coastal wetlands in the
Heʻeia National Estuarine Research Reserve as researchers from the Hawaiʻi Institute for Marine Biology
work to restore nearby coral reefs (Figure 19). The following case study describes both projects, using
the Hawaiʻi Assessment results to demonstrate the utility of various outputs to evaluate potential
locations to site and plan similar types of resilience efforts.

Figure 19. Map showing the location of wetland (left) and coral reef (right) restoration projects in Kāneʻohe Bay on
east Oʻahu.
7

https://www.nfwf.org/programs/national-coastal-resilience-fund
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Including the communities of Kāneʻohe, ʻĀhuimanu, and Kahaluʻu, Kāneʻohe Bay is home to a growing
population of over 30,000 residents. Decades of industrialized agriculture and urbanization have altered
the landscape, leaving coastal communities vulnerable to flooding from large rain events. For instance,
in 2016 Tropical Storm Darby produced over nine inches of rain in just 24 hours, causing widespread
flooding. Such events also convey large volumes of sediment and nutrient-laden runoff into the Bay,
threatening sensitive coral reef ecosystems. When the effects of inland flooding are coupled with the
impacts of storm surge and sea level rise, the results of the Hawaiʻi Assessment reveal that the
communities around Kāneʻohe Bay are exposed to significant flooding threats (Figure 20). With storms
expected to increase in frequency and intensity due to climate change, projects that restore and protect
natural systems are more important than ever to buffer communities from the impacts of flooding. For
instance, the impacts of storm surge (Figure 21) and sea level rise (Figure 22) demonstrate the
importance of the ongoing wetland and coral restoration efforts in the area.

Figure 20. The Community Exposure Index results for Kāne ʻohe Bay reveal significant exposure to flooding threats
throughout the Bay. The black lines outline the wetland and coral restoration project locations.

Figure 21. Wetland and coral reefs can help to minimize the impacts of flood threats such as storm surge. The black
lines outline the wetland and coral restoration project locations.
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Figure 22. Wetland and coral reefs can help to minimize the impacts of flood threats such as sea level rise. Over time,
sea level rise will exacerbate other flood-related threats. The black lines outline the wetland and coral restoration
project locations

4.1.1 Restoring the Heʻeia Wetlands
Local planning efforts have long highlighted the importance of restoring and conserving the highly
degraded wetland system at the mouth of the Heʻeia stream. In the early 1900s, red mangroves
(Rhizophora mangle) were introduced to the Hawaiian Islands (Hiromasa Browning 2020). While in other
parts of the world, mangroves are noted for their coastal protection and ecosystem benefits, in Hawaiʻi,
invasive mangroves forests alter estuarine function and negatively impact native species. In the Heʻeia
stream, thick mangrove stands block passage and reduce available nursery habitat for native and
important resource fishes (Figure 23).

Figure 23. Degraded wetlands at the mouth of the He ʻeia stream. Left: Invasive red mangrove trees cover the
streambanks while invasive mosquito fern (Azolla spp.) covers the water surface. Right: Restored area after
mangroves have been cut but not removed, clearing the area so native species can be planted. Photo Credits: Bridget
Lussier, NOAA (left), Kanekoa Shultz, TNC (right).

In response, The Nature Conservancy (TNC) in partnership with the Hawaiʻi Department of Aquatic
Resources, is working to restore 26 acres of degraded coastal wetland to provide flood protection,
reduce land-based sources of pollution, and remove barriers to fish passage on the Heʻeia stream. The
project builds upon recent, successful efforts to remove invasive mangroves from six acres of wetland
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(Figure 23). TNC and partners will work to remove mangroves from an additional six acres, taking
measures to minimize sediment loss into the Bay by leaving the mangroves’ submerged root system in
place. With the mangroves removed, the team can plant native vegetation, helping to restore natural
estuarine function while opening nearly half a mile of the stream channel for fish passage.
In addition to restoring the wetlands at the mouth of Heʻeia stream, TNC will also maintain and enhance
the function of an additional 14 acres of wetland habitat further inland. The project will restore
wetlands with loʻi kalo (taro fields), creating habitat for birds, fishes, and other species while maintaining
traditional Hawaiian agricultural practices. The constructed wetlands will also serve as retention basins
capable of slowing the flow of water during storm events, helping to protect the dense concentration of
community assets surrounding the project site (Figure 24).

Figure 24. The Community Asset Index shows dense concentrations of community assets throughout the Kāne ʻohe
Bay. The black lines outline the wetland and coral restoration project locations. Note the high density of community
assets surrounding the wetland restoration site north of Kāne ʻohe.

The constructed wetlands will increase the residence time and facilitate sediment and nutrient
retention. Together, these efforts are expected to retain approximately 400 tons of sediment per year
on the landscape, reducing the amount of sediments reaching the nearshore fishpond and coral reefs
(Figure 25). This project exemplifies integrating habitat restoration with food security, native and
endangered species conservation, coastal storm protection, and managing land-based sources of
sediment to protect coral reefs.
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Figure 25. Aerial view of the Heʻeia watershed and wetlands. Extensive mangrove forests can be seen
along the coast and border the He ʻeia fishpond. Portions of the cleared agricultural lands will be
restored with constructed wetlands and loʻi kalo (taro fields). Photo Credit: Manuel Mejia, TNC.

4.1.2 Coral Reef Restoration
Kāneʻohe Bay is the largest sheltered bay in Hawaiʻi, supporting a large fringing coral reef that serves as
a living seawall capable of dissipating wave energy and protecting nearby shorelines. However, multiple
local and global stressors threaten coral reef ecosystems in Kāneʻohe Bay and across Hawaiʻi, potentially
limiting their ability to provide both coastal protection and biodiversity benefits. The wetland
restoration efforts described above and throughout the Heʻeia watershed will improve water quality for
adjacent coral reefs by reducing sediment and nutrient pollution.
Despite these improvements, additional conservation efforts are required to help protect coral reefs
from the devastating effects of warming ocean temperatures due to climate change. In the last five
years, Hawaiʻi has experienced an unprecedented series of three bleaching events causing widespread
coral morality. In Kāneʻohe Bay, researchers from the Gates Coral Lab at the Hawaiʻi Institute of Marine
Biology (HIMB) discovered that some coral species, and individual colonies of the same species, are
more resistant to bleaching than others and may be considered more thermally-tolerant (Figure 26).
Identifying thermally-tolerant coral stocks and growing them in underwater coral nurseries will enable
HIMB researchers to collaborate with DAR, NOAA, and local partners in restoring reefs with corals that
not only survive today but persist under future conditions.
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Figure 26. Coral restoration efforts in Kāneʻohe Bay. Left: During the 2015 bleaching event, both bleached (tag #39)
and healthy (tag #40) coral colonies could be found side-by-side. Right: Bleaching resistant coral fragments are
attached to nursery tables. Photo Credits: Chris Wall (left), Julia Royster, NOAA (right).

The project will establish two nurseries in Kāneʻohe Bay that will allow for stress-resistant corals to be
outplanted to suitable sites throughout the area. The outplanted corals will provide immediate benefits
to surrounding communities and are expected to continue to grow and provide benefits for years to
come, even as temperatures and sea levels rise. As demonstrated by the Hawaiʻi Assessment, the Fish
and Wildlife Index shows the highest values further offshore, indicating restoration efforts within the
bay may also help enhance coral habitat for myriad reef-associated species (Figure 27).

Figure 27. Fish and Wildlife Index results for Kāneʻohe Bay. The black lines outline the wetland and coral restoration
project areas. Note the high fish and wildlife values within and adjacent to the nearshore coral restoration site. Efforts
to restore corals in this location may help to expand areas of high fish and wildlife value.

In addition to transplanting in Kāneʻohe Bay, the project will also build nurseries and plant thermallytolerant coral colonies in Maunalua Bay and along the urban south shore of Oʻahu to protect the
Honolulu Airport. At Maunalua Bay, project partner Mālama Maunalua will lead outreach and
community engagement through their existing networks to give a voice to residents and encourage
community-based natural resource management. This partnership will empower volunteer citizen

33

scientists to take part in this groundbreaking work that builds coral reefs adapted to warmer future
conditions. This pilot study will result in a framework to determine how best to engage community
groups to scale-up future climate-wise restoration work across the State of Hawaiʻi.
With the presence of considerable flooding threats, concentrations of coastal community assets, and
wildlife habitat, the Kāneʻohe Bay wetland and coral restoration projects demonstrate the importance of
placing resilience projects in areas that can achieve dual benefits for communities and fish and wildlife.
The Assessment reveals how Resilience Hubs are a useful tool to identify areas suitable for naturebased, resilience-building interventions. In the areas surrounding Kāneʻohe, a range of high-ranking
Hubs are visible (Figure 28). Additionally, by visualizing the 4-hectare (10-acre) hexagonal grid, users can
access finer-resolution information to understand the variation in scores within Resilience Hubs. The
Resilience Hubs in Kāneʻohe Bay, and throughout Hawaiʻi, can help support the prioritization of habitats
for similar types of projects in Oʻahu and elsewhere.

Figure 28. Resilience Hubs (black lines) indicate that there are multiple areas potentially well suited for restoration
projects. Note the 4-hectare (10-acre) hexagons show variation in scores within Resilience Hubs. The thick black lines
outline the wetland and coral restoration project areas.
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CONCLUSION
5.1 Summary and Key Takeaways
As communities across Hawaiʻi deal with current and future flooding threats from natural events, tools
such as this Coastal Resilience Assessment can help decision-makers and other stakeholders use data to
make informed decisions about how to identify areas that may be suitable for resilience-focused and
nature-based restoration projects. NFWF and NOAA remain committed to supporting programs and
projects that improve community resilience by reducing communities’ vulnerability to coastal storms,
sea-level rise, and other types of coastal flooding by strengthening natural ecosystems and the fish and
wildlife habitat they provide.
With nearly 1,300 kilometers of coastline combined across all islands, Hawaiʻi remains exposed to a
variety of coastal-flood related hazards. The effects of flood-related hazards are compounded in areas
with higher populations and assets, such as in Honolulu, Kāneʻohe Bay, Kahului, Hilo, and Kailua Kona.
Inland communities are not immune to flood-related threats, especially as they relate to heavy
precipitation events and flash flooding. Furthermore, the effects of coastal flooding are exacerbated
when combined with heavy precipitation inland, suggesting efforts to build resilience should consider
the benefits of a holistic, watershed-wide approach.
Hawaiʻi is ecologically diverse, with an abundance of wildlife assets, both in the terrestrial and marine
environments. Combining the information in the Fish and Wildlife Index with the Community Exposure
Index, the Assessment identified numerous Resilience Hubs, or areas where resilience-building projects
may benefit both human and wildlife communities throughout Hawaiʻi.

5.2 Future Work
The Regional Coastal Resilience Assessments were developed through an iterative process supported by
substantial guidance from technical and regional experts. The Regional Assessments and the associated
Coastal Resilience Evaluation and Siting Tool (CREST) will continue to be updated, refined, and expanded
in the future as appropriate. The overarching methodology will continue to be vetted and refined as
needed through ongoing Regional Assessments across the United States. The application and continued
development of the Assessments will assist NFWF and others in the implementation of nature-based
solutions that build community resilience to flooding threats while benefiting fish and wildlife
populations nationwide.

35

REFERENCES
Beven, J.L., and Wroe, D. (2019) Tropical Cyclone Report: Hurricane Lane. NOAA National Weather Service,
National Hurricane Center, Central Pacific Hurricane Center, EP142018. Report available online:
https://www.nhc.noaa.gov/data/tcr/EP142018_Lane.pdf.
Bridges, T.S., Wager, P.W., Burks-Copes, K.A., Bates, M.E., Collier, Z., Fischenich, C.J., Gailani, J.Z., Leuck, L.D.,
Piercy, C.D., Rosati, J.D., Russo, E.J., Shafer, D.J., Suedel, B.C., Vuxton, E.A., Wamsley, T.V. (2014) Use of
Natural and Nature-Based Features (NNBF) For Coastal Resilience. ERDC SR-15-1. Vicksburg, MS: U.S. Army
Engineer Research and Development Center. Report available online:
https://usace.contentdm.oclc.org/digital/collection/p266001coll1/id/3442/.
Courtney, C.A., Gelino, K., Romine, B.M., Hintzen, K.D., Addonizio-Bianco, C., Owens, T.M., Lander, M., Buika, J.
(2019) Guidance for Disaster Recovery Preparedness in Hawaiʻi. Prepared by Tetra Tech, Inc. for the University
of Hawaiʻi Sea Grant College Program and State of Hawaiʻi Department of Land and Natural Resources and
Office of Planning, with funding from National Oceanic and Atmospheric Administration Office for Coastal
Management award no. NA16NOS4730016. Available online: https://seagrant.soest.hawaii.edu/wpcontent/uploads/2019/07/HI_Disaster_Recovery_Preparedness_Guidance_Final_26June2019.pdf
Dobson, J.G., Johnson, I.P., Rhodes, K.A., Lussier, B.C., Byler, K.A. (2020) Regional Coastal Resilience Assessments:
Methodology and Data Report. UNC Asheville National Environmental Modeling and Analysis Center,
Asheville, NC. Prepared for the National Fish and Wildlife Foundation. Available online:
https://www.nfwf.org/programs/national-coastal-resilience-fund/regional-coastal-resilience-assessment.
Fletcher, C.H., Grossman, E.E., Richmond, B.M. Gibbs, A.E. (2002) Atlas of Natural Hazards in the Hawaiian Coastal
Zone. US Geological Survey Publication, Series I-2761. Prepared in cooperation with University of Hawaiʻi,
State of Hawaiʻi Office of Planning, and National Oceanic and Atmospheric Administration. Available online:
https://pubs.usgs.gov/imap/i2761/i2761.pdf.
Firehock, K. and Walker, R.A. (2019) Green Infrastructure: Map and Plan the Natural World with GIS. Esri Press,
First Edition. ISBN: 9781589484863.
Gornitz, V.M., Daniels, R.C., White, T.W., Birdwell, K.R. (1994) The Development of a Coastal Risk Assessment
Database: Vulnerability to Sea-Level Rise in the U.S. Southeast. Journal of Coastal Research 12: 327-338.
http://www.jstor.org/stable/25735608.
Gregg, R.M. (Ed.) (2018) Hawaiian Islands Climate Vulnerability and Adaptation Synthesis. EcoAdapt, Bainbridge
Island, WA. Available online:
https://www.cakex.org/sites/default/files/documents/EcoAdapt_Hawaiian%20Islands%20Climate%20Vulnera
bility%20and%20Adaptation%20Synthesis%20Report_January2018.pdf.
[Hawaiʻi Climate Commission 2017] Hawaiʻi Climate Change Mitigation and Adaptation Commission. (2017) Hawaiʻi
Sea Level Rise Vulnerability and Adaptation Report. Prepared by Tetra Tech, Inc. and the State of Hawaiʻi
Department of Land and Natural Resources, Office of Conservation and Coastal Lands, under the State of
Hawaiʻi Department of Land and Natural Resources Contract No: 64064. Available online:
https://climateadaptation.hawaii.gov/wp-content/uploads/2017/12/SLR-Report_Dec2017.pdf.
[Hawaiʻi DLNR 2015] Hawaiʻi Department of Land and Natural Resources. (2015) Hawaiʻi State Wildlife Action Plan.
Prepared by H.T. Harvey and Associates, Honolulu, Hawaiʻi.
[Hawaiʻi CZM 2019] Coastal Zone Management Program, Office of Planning (2019) Assessing the Feasibility and
Implications of Managed Retreat Strategies for Vulnerable Coastal Areas in Hawai ʻi. Prepared with support
from SSFM International, Inc. Available online:
https://files.hawaii.gov/dbedt/op/czm/ormp/assessing_the_feasibility_and_implications_of_managed_retrea
t_strategies_for_vulnerable_coastal_areas_in_hawaii.pdf.

36

[Hawaiʻi CZM 2020] Hawaii Coastal Zone Management Program. (2020) Hawaiʻi Ocean Resources Management
Plan: Collaborative Coastal Zone Management from Mauka to Makai. Hawaiʻi Office of Planning. Available
online: https://planning.hawaii.gov/czm/ormp/.
Hiromasa Browning, J., Reeves, M., Amidon, F., Miller, S., Charrier, J.C. (2020) Hawaiʻi: The Wetland System of
Hawaiʻi. Editors: Michael I. Goldstein & Dominick A. DellaSala. Encyclopedia of the World’s Biomes. Elsevier
Pages 211-234. ISBN 9780128160978. https://doi.org/10.1016/B978-0-12-409548-9.11915-3.
Hwang, D.J. and Okimoto, D.K. (2019) Homeowner’s Handbook to Prepare for Natural Hazards. Published by the
University of Hawaiʻi Sea Grant College Program. Fourth Edition, Version 4.0. Available online:
https://seagrant.soest.hawaii.edu/wp-content/uploads/2019/12/Hawaii-Homeowners-Handbook-Fourth-Ed.final1.pdf.
Keener, V.W., Marra, J.J., Finucane, M.L., Spooner, D., Smith, M.H. (Eds.) (2012) Climate Change and Pacific Islands:
Indicators and Impacts. Report for the 2012 Pacific Islands Regional Climate Assessment. Washington, DC:
Island Press. Available online at: https://www.cakex.org/sites/default/files/documents/NCA-PIRCA-FINAL-intprint-1.13-web.form_.pdf.
Komyakova, V., Munday, P.L., Jones, G.P. (2013) Relative Importance of Coral Cover, Habitat Complexity and
Diversity in Determining the Structure of Reef Fish Communities. PLoS ONE 8(12): e83178.
https://doi.org/10.1371/journal.pone.0083178.
Narayan, S., Beck, J.W., Wilson, P., Thomas, C.J., Guerrero, A., Shepard, C.C., Reguero, B.G., Franco, G., Ingram, J.C.,
Trespalacios, D. (2017) The Value of Coastal Wetlands for Flood Damage Reduction in the Northeastern USA.
Scientific Reports 7(9463). https://doi.org/10.1038/s41598-017-09269-z.
[NJ-DEP 2011] New Jersey Department of Environmental Protection, Office of Coastal Management (2011) New
Jersey’s Coastal Community Vulnerability Assessment and Mapping Protocol. Report available online at:
http://www.midatlanticocean.org/022013_njccva_mp.pdf.
Tetra Tech (2018) State of Hawaiʻi 2018 Hazard Mitigation Plan. Prepared for Hawaiʻi Emergency Management
Agency. Available online: https://dod.hawaii.gov/hiema/files/2018/11/State-of-Hawaii-2018-MitigationPlan.pdf.
van Rees (2018) Wetland Conservation in Hawaiʻi and the Need for Flagship Species. ʻElepaio Journal of the Hawaii
Audubon Society 78(5): 37-41.

37

APPENDIX
The following sections describe data used for the Hawaiʻi Coastal Resilience Assessment in detail, as well
as any regional deviations from the methodologies outlined in the Methodology and Data Report
(Dobson et al. 2020).
The Hawaiʻi Assessment was completed at a 10-meter resolution, using the projection NAD 1983 UTM
Zone 4N (WKID 26904).

A. Data Summary
A.1 Threat Index
The following is a comprehensive list of datasets used to create the Threat Index for the Hawaiʻi Coastal
Resilience Assessment. Bolded layer names indicate the source data were specific to the Hawaiʻi
Assessment.
Layer Name

Dataset and Source

Flood-prone Areas

FEMA National Flood Hazard Layers, USDA-NRCS SSURGO (2.2 or later)

Sea Level Rise

Pacific Islands Ocean Observing System, Tetra Tech, Inc., University of Hawaii Coastal
Geology Group Sea Level Rise Exposure Area (2017)

Storm Surge

NOAA/NHC Sea, Lake, and Overland Surge from Hurricanes (SLOSH) model (2018
models)

Areas of Low Slope

USGS National Elevation Dataset, 10-meter resolution (most recent available)

Soil Erodibility

USDA-NRCS SSURGO (2.2 or later)

Impervious Surfaces

USDA-NRCS SSURGO (2.2 or later), NOAA Coastal Change Analysis Program Landcover
(2010: Hawaiʻi, Kauaʻi, Maui, Molokaʻi, Niʻihau; 2011: Lānaʻi, Oʻahu)

Geologic Stressors:
Landslide
Susceptibility

USGS Preliminary Landslide Susceptibility Maps and Data for Hawaii (2018)

Tsunami Evacuation
Zones

Pacific Disaster Center, City and County of Honolulu, County of Kauaʻi, County of Maui,
and County of Hawaiʻi (via Hawaiʻi Statewide GIS Program)
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A.2 Community Asset Index
The following is a comprehensive list of datasets used to create the Community Asset Index for the
Hawaiʻi Coastal Resilience Assessment. Bolded layer names indicate the source data was specific to the
Hawaiʻi Assessment.
Layer Name

Dataset and Source

Population Density

U.S. Census Bureau American Community Survey 5-year Estimates (2014-2018, Block
Group)

Social Vulnerability

U.S. EPA Environmental Justice Screening and Mapping tool (2019)

Critical Facilities

Schools: Public Schools (HI State Dept. of Education), Private Schools (HI Association of
Independent Schools), Preschools ( HI Executive Office on Early Learning); Fire Stations:
HI Statewide GIS Program/Office of Planning, Police Stations: HI Statewide GIS
Program/Office of Planning; and Medical Facilities: Hospitals (Pacific Disaster Center),
Skilled Nursing Facilities (HI Dept. of Public Health), Assisted Living Facilities (State of HI
Dept. of Health)

Parcels

Hawaii Statewide GIS Program/Office of Planning

Building Footprints

Open Street Maps/digitized by NEMAC team

Critical Infrastructure (Various Inputs, see below)
Primary roads

Open Street Maps; TigerLine roads (2019)

Bridges

Federal Highway Administration: National Bridge Inventory via Hawaiʻi Statewide GIS
Program/Office of Planning

Airport runways

Hawaii Dept. of Transportation, Airports Division (Hawaiʻi Statewide GIS Program)

Ports

Hawaii State Dept. of Transportation, Harbors Division: Commercial Harbors; USACE Ports

Power
Plants/Substations

U.S. Energy Information Administration: EIA-860, Annual Electric Generator Report; EIA-860M,
Monthly Update to the Annual Electric Generator Report; EIA-923, Power Plant Operations Report
(2016 or later)

Wastewater treatment
facilities

Hawaiʻi Statewide GIS Program/Office of Planning

Railroads (urban train)

HART guideway track alignments - CH2M

Major dams

USACE National Inventory of Dams (Hawaii Statewide GIS Program)

Petroleum terminals

U.S. Energy Information Administration: EIA-815, Monthly Bulk Terminal and Blender Report

Petroleum Refineries

U.S. Energy Information Administration: EIA-820 Refinery Capacity Report (2015 or later)

Hazardous Sites

U.S. EPA Facility Registry Service (2016 or later)

Cultural & Historic
Resources

Hawaiʻi State Historic Preservation Division (Fishponds, existing archaeological sites, cultural
resources, historic structures and buildings)
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A.3 Terrestrial Index
The following table lists those datasets that were used to create the Terrestrial Index for Hawaiʻi.

Dataset Name

Source and Year

C-CAP Land cover

NOAA Office for Coastal Management; 2010: Hawaiʻi, Kauaʻi, Maui,
Molokaʻi, Niʻihau; 2011: Lānaʻi, Oʻahu

National Wetlands Inventory

U.S. Fish and Wildlife Service (most recent available)

National Hydrography Dataset

U.S. Geological Survey (USGS) 1:24,000

Carbon Assessment of Hawaiʻi Land Cover - Biome Unit

USGS/Hawaiʻi Statewide GIS Program, Office of Planning (2015)

Important Bird Areas & Key
Biodiversity Areas

BirdLife International (2020)

Environmental Sensitivity Index
Species Habitat

NOAA Office of Response and Restoration (2000)

Critical Habitat Designations

NOAA & U.S. Fish and Wildlife Service (most recent available)

State Wildlife Action Plan species
list

Hawaiʻi Dept. of Land and Natural Resources (2015)

Habitat Classification Scheme

IUCN Red List of Threatened Species (Version 3.1)

Protected Areas Database of the
U.S. (PADUS)

USGS (Version 2.0)

Watershed Partnerships

State of Hawaiʻi, Dept. of Land and Natural Resources, Division of Forestry
and Wildlife

Ridge to Reef Restoration Areas

West Maui Ridge to Reef Initiative, South Kohala Coastal Partnership

State Watershed Priority Areas

State of Hawaiʻi, Division of Forestry and Wildlife
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A.4 Marine Index
The following table lists those datasets used to create the Marine Index for Hawaiʻi.

Dataset Name

Source and Year

Critical Habitat Designations

NOAA Fisheries (most recent available)

Essential Fish Habitat

NOAA Fisheries (2018)

Habitat Areas of Particular Concern

NOAA Fisheries (2018)

Coral Cover Surveys

NOAA National Coral Reef Monitoring Program, strata-level data (2019)

Protected Areas Database of the U.S.
(PADUS) - Marine Protected Areas

USGS (Version 2.0)

Bathymetric Data

NOAA NCEI Coastal Relief Model

Humpback Whale National Marine
Sanctuary

NOAA National Marine Sanctuary Program

Marine Managed Areas in the Main
Hawaiian Islands

Hawaiʻi Division of Aquatic Resources

Reef Fish Biomass

NOAA National Coral Reef Monitoring Program: Reef Fish Monitoring
sector-level data (2019)

A.5 Resilience Hubs
The following table lists those datasets used to create the Resilience Hubs for Hawaiʻi.

Dataset Name

Source and Year

C-CAP Land Cover Atlas

NOAA Office for Coastal Management; 2010: Hawaiʻi, Kauaʻi, Maui,
Molokaʻi, Niʻihau; 2011: Lānaʻi, Oʻahu

National Wetlands Inventory

U.S. Fish and Wildlife Service (most recent data available)

National Hydrography Dataset

U.S. Geological Survey (USGS) 1:24,000

Bathymetric Data

NOAA NCEI Coastal Relief Model

Coral Cover Surveys

NOAA National Coral Reef Monitoring Program, strata-level data (2019)

Benthic Habitat Maps

NOAA National Centers for Coastal Ocean Science (2007)

National Elevation Dataset

U.S. Geological Survey (USGS), EROS Data Center

SSURGO Soils Survey

USDA-NRCS SSURGO (2.2 or later)

Roads polyline

OpenStreetMap (latest data available)
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B. Detailed Methodology: Threat Index
The Threat Index for Hawaiʻi was created by following the methodology outlined in the Methodology
and Data Report (Dobson et al. 2020). Any changes to the inputs used in this region, and their sources,
are listed in Appendix A.1.

B.1 Create the Sea Level Rise Exposure Area Input
Models from the University of Hawaiʻi Coastal Geology Group and Tetra Tech, Inc., were combined into
Sea Level Rise Exposure Areas. It was recommended during the Assessment workshop and by the
Advisory Committee that these data were used in place of the NOAA sea level rise scenarios. The Sea
Level Rise Exposure Area dataset uses modeled passive flooding, annual high wave flooding, and coastal
erosion, all specific to the Hawaiian Islands.
A. Merge all sea level rise scenarios together.
a. Geoprocessing > Merge
B. Create a “Rank” attribute in each Sea Level Rise layer
a. Right click layer in attribute table > open attribute table
b. Add field “Rank”; field type: Short Integer
c. Right click the Rank field and use Field Calculator to add values according to the table
below
C. Merge the individual sea level rise inundation vectors in ascending Rank value order to create
one complete vector containing all levels of sea level rise.
a. Geoprocessing > Merge
D. Expand resulting features to cover the entire regional area before rasterizing to ensure the data
is continuous across the entire watershed region. This step is essential for the final raster
calculations in the Assessment.
a. Merge Sea Level Rise vector output with the watershed region.
i.
Geoprocessing > Merge
E. Make sure values outside of any Sea Level Rise inundation scenarios within the watershed
region are a value of 0 in the Rank attribute field. If they are NULL, change them to 0.
F. Convert merged SLR vector to raster:
a. Conversion Tools > To Raster > Polygon to Raster
i.
Value Field: Rank
ii.
Cell assignment type: Maximum Area
iii.
Priority field: Rank
iv.
Cell size: varies by region
G. Shift the raster input
a. Data Management Tools > Projections and Transformations > Raster > Shift
i.
Shift X & Y Coordinates by: 1 (each)
ii.
Input Snap Raster: varies by region
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Sea Level Rise

Rank Type

Rank Value

No inundation / No data

None

0

Inundation with 3.2ft rise in sea level

Low

2

Inundation with 2ft rise in sea level

Moderate

3

Inundation with 1.1ft rise in sea level

High

4

Inundation with 0.5ft rise in sea level

Very high

5

B.2 Create the Tsunami Evacuation Zones Input
A. Create a “Rank” attribute in each Tsunami Evacuation layer
a. Right click layer in attribute table > open attribute table
b. Add field “Rank”; field type: Short Integer
c. Right click the Rank field and use Field Calculator to add values:
i.
Tsunami Evacuation Zones Rank = 2
ii.
Extreme Tsunami Evacuation Zones = 1
B. Merge the individual Tsunami Evacuation vectors in ascending Rank value order to create one
complete vector containing all levels of sea level rise.
a. Geoprocessing > Merge
C. Expand resulting features to cover the entire regional area before rasterizing to ensure the data
is continuous across the entire watershed region. This step is essential for the final raster
calculations in the Assessment.
a. Merge Sea Level Rise vector output with the watershed region.
i.
Geoprocessing > Merge
D. Make sure values outside of any Evacuation Zone within the watershed region are a value of 0 in
the Rank attribute field. If they are NULL, change them to 0.
E. Convert merged vector to raster:
a. Conversion Tools > To Raster > Polygon to Raster
i.
Value Field: Rank
ii.
Cell assignment type: Maximum Area
iii.
Priority field: Rank
iv.
Cell size: varies by region
F. Shift the raster input
a. Data Management Tools > Projections and Transformations > Raster > Shift
i.
Shift X & Y Coordinates by: 1 (each)
ii.
Input Snap Raster: varies by region

B.3 Create the Geostress: Landslide Susceptibility Input
A. Create a “Rank” attribute for each level of susceptibility
a. Right click layer in attribute table > open attribute table
b. Add field “Rank”; field type: Short Integer
c. Right click the Rank field and use Field Calculator to add values according to the table
below
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B. Merge the landslide susceptibility feature to cover the entire regional area before rasterizing to
ensure the data is continuous across the entire watershed region. This step is essential for the
final raster calculations in the Assessment.
a. Merge Sea Level Rise vector output with the watershed region.
i.
Geoprocessing > Merge
C. Make sure values outside of the landslide susceptibility areas within the watershed region are a
value of 0 in the Rank attribute field. If they are NULL, change them to 0.
D. Convert merged vector to raster:
a. Conversion Tools > To Raster > Polygon to Raster
i.
Value Field: Rank
ii.
Cell assignment type: Maximum Area
iii.
Priority field: Rank
iv.
Cell size: varies by region
E. Shift the raster input
a. Data Management Tools > Projections and Transformations > Raster > Shift
i.
Shift X & Y Coordinates by: 1 (each)
ii.
Input Snap Raster: varies by region

Landslide Susceptibility

Rank Value

0

0

Moderate

1

High

2

Very High

3

B.4 Calculating the Threat Index
The Threat Index was classified into 10 classes in order to multiply them and ultimately create the
Community Exposure Index. Below is the classification that was used for the Hawaiʻi Threat Index.

Hawaiʻi Threat Index Distribution
Threat
Index
Break
Value

0

1

2

3

4

5

6

7-9

10

11 - 32

Final Rank
Value

1

2

3

4

5

6

7

8

9

10
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C. Detailed Methodology: Community Asset Index
The Community Assets Index for Hawaiʻi was created by following the methodology outlined in the
Methodology and Data Report (Dobson et al. 2020). Any changes to the inputs used in this region, and
their sources, are listed in Appendix A.2.

C.1 Population Density
Following the methodology for population density detailed in the Methodology and Data Report
(Dobson et al. 2020), the distribution shown in the table below was used to rank population density in
Hawaiʻi.

Population Density Distribution for Hawaiʻi

Rank Value

0

0

<= 18.6

1

<= 73.8

2

<= 196.8

3

<= 378.3

4

<= 3205.3

5

C.2 Social Vulnerability
Following the methodology for social vulnerability as detailed in the Methodology and Data Report
(Dobson et al. 2020), the distribution shown in the table below was used to rank social vulnerability in
Hawaiʻi.

Social Vulnerability Distribution for Hawaiʻi

Rank Value

0

0

<= 49.7

1

<= 54.9

2

<= 60

3

<= 66.5

4

<= 88.3

5

C.3 Modifications Made to the Critical Infrastructure and Critical Facilities Inputs
Specific critical infrastructure and facilities were reviewed for each region to identify any data that were
non-applicable and/or any additional inputs that should be considered. The table in Appendix A.2
identifies data source and data inputs that were included in the Hawaiʻi Assessment.
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Infrastructure and facility data inputs were included in the analysis following the same methodologies
found in the Methodology and Data Report (Dobson et al. 2020).

C.4 Calculating the Community Asset Index
The Community Asset Index was classified into 10 classes to multiply them and ultimately create the
Community Exposure Index. Below is the classification that was used for the Hawaiʻi Community Asset
Index.

Hawaiʻi Community Asset Index Distribution
Asset
Index
Break
Value

0

1

2

3

4

5

6
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8

9 - 17

Final Rank
Value

1
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3

4

5

6

7

8

9

10

D. Detailed Methodology: Community Exposure Index
After classifying both the Threat and Community Asset Indices into 10 classes each, they were multiplied
to create the Community Exposure Index. Exposure is the overlap of community assets and flood
threats. As this multiplication results in a final index with values from 1-100, the Community Exposure
Index was further classified to make it easier to work with and understand the results. The distribution
used for the Community Exposure Index in Hawaiʻi is shown below.

Hawaiʻi Community Exposure Index Distribution
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9
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E. Detailed Methodology: Fish and Wildlife Index
E.1 Calculating the Terrestrial Index
The Terrestrial Index for Hawaiʻi is based on the same methodology described in the Methodology and
Data Report (Dobson et al. 2020). However, because of regional differences, the taxonomic groups
between regions may differ. Taxonomic groups included are dependent on the species of concern as
determined by each region’s State Wildlife Action Plan and species listed under the Endangered Species
Act. Habitat preferences for those species were then identified in the IUCN Red List of Threatened
Species. The following species groups and associated species were incorporated into the Terrestrial
Index for Hawaiʻi.

Forest Birds
Palila (Loxioides bailleui)
Kauaʻi ʻĀkepa (ʻAkekeʻe) (Loxops caeruleirostris)
Hawaiʻi ʻĀkepa (Loxops coccineus coccineus)
Kiwikiu (Maui Parrotbill) (Pseudonestor xanthophrys)
ʻŌʻū (Psittirostra psittacea)
ʻIʻiwi (Vestiaria coccinea)
Kauaʻi Nuku puʻu (Hemignathus lucidus hanapepe)
Hawaiian Crow (ʻAlalā) (Corvus hawaiiensis)
Maui Nuku puʻu (Hemignathus lucidus affinis)
ʻApapane (Himatione sanguinea)
ʻAkiapōlāʻau (Hemignathus munroi)
Mauʻi ʻĀkepa (Loxops coccineus ochraceus)
Lesser ʻAmakihi (ʻAnianiau) (Magumma
(Hemignathus) parva)

Molokaʻi Thrush (Olomaʻo) (Myadestes lanaiensis)
Hawaiʻi Thrush (ʻŌmaʻo) (Myadestes obscurus)
Small Kauaʻi Thrush (Puaiohi) (Myadestes palmeri)
Kauaʻi Creeper (ʻAkikiki) (Oreomystis bairdi)
Crested Honeycreeper (ʻĀkohekohe) (Palmeria dolei)
Oʻahu Creeper (Oʻahu ʻAlauahio) (Paroreomyza
maculata)
Maui Creeper (Maui ʻAlauahio) (Paroreomyza
montana)
Oʻahu ʻElepaio (Chasiempis sandwichensis ibidis)
Kauaʻi ʻElepaio (Chasiempis sandwichensis sclateri)
Oʻahu ʻAmakihi (Hemignathus flava)
Kauaʻi ʻAmakihi (Hemignathus kauaiensis)
Hawaiʻi ʻAmakihi (Hemignathus virens)

Seabirds
Black Noddy (Noio) (Anous minutus)
Brown Noddy (Noio Kōhā) (Anous stolidus)
Bulwerʻs Petrel (ʻOu) (Bulweria bulwerii)
Blue-gray Noddy (Procelsterna cerulea)
Masked Booby (ʻĀ) (Sula dactylatra)
White Tern (Manu-o-Kū) (Gygis alba)
Newellʻs Shearwater (ʻAʻo) (Puffinus auricularis
newelli)
Brown Booby (ʻĀ) (Sula leucogaster)
Red-footed Booby (ʻĀ) (Sula sula)
Dark-rumped Petrel (Pterodroma phaeopygia
sandwichensis)
Black-footed Albatross (Kaʻupu) (Phoebastria
nigripes)
Great Frigatebird (Fregata minor)
Christmas Shearwater (Puffinus nativitatis)

Band-rumped Storm Petrel (ʻAkēʻakē)
(Oceanodroma castro)
Tristramʻs Storm-Petrel (Oceanodroma tristrami)
Sooty Tern (ʻEwaʻewa) (Sterna fuscatus)
Spectacled Tern (Onychoprion lunatus)
White-tailed Tropicbird (Koaʻe kea) (Phaethon
lepturus)
Red-tailed Tropicbird (Koaʻe ʻula) (Phaethon
rubricauda)
Short-tailed Albatross (Phoebastria albatrus)
Laysan Albatross (Mōlī) (Phoebastria immutabilis)
Bonin Petrel (Pterodroma hypoleuca)
Hawaiian Petrel (ʻUaʻu) (Pterodroma sandwichensis)
Wedge-tailed Shearwater (ʻUaʻu kani) (Puffinus
pacificus)
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Waterbirds
Hawaiian Duck (Koloa maoli) (Anas wyvilliana)
Hawaiian Goose (Nēnē) (Branta sandvicensis)
Hawaiian Coot (ʻAlae keʻokeʻo) (Fulica alai)

Black-crowned Night Heron (ʻAukuʻu) (Nycticorax
nycticorax hoactli)
Hawaiian Common Moorhen (ʻAlae ʻula) (Gallinula
chloropus sandvicensis)
Hawaiian Stilt (Aeʻo) (Himantopus mexicanus
knudseni)

Migratory Birds
Northern Pintail (Koloa Māpu) (Anas acuta)
American Wigeon (Anas americana)
Northern Shoveler (Koloa Mōhā) (Anas clypeata)
Ruddy Turnstone (ʻAkekeke) (Arenaria interpres)
Lesser Scaup (Aythya affinis)

Bristle-thighed Curlew (Kioea) (Numenius tahitiensis)
Wandering Tattler (ʻŪlili) (Heteroscelus incanus)
Sanderling (Hunakai) (Calidris alba)
Pacific Golden Plover (Kōlea) (Pluvialis fulva)

Raptors
Hawaiian Hawk (ʻIo) (Buteo solitarius)
Pueo (Asio flammeus sandwichensis)

Terrestrial Mammals
Hawaiian Hoary Bat (ʻōpeʻapeʻa) (Lasiurus cinereus semotus)

Reptiles
Loggerhead (Caretta caretta)
Green Sea Turtle (Honu) (Chelonia mydas)
Leatherback Turtle (Dermochelys coriacea)

Hawksbill Sea Turtle (Eretmochelys imbricata)
Olive Ridley Sea Turtle (Lepidochelys olivacea)
Yellowbelly Sea Snake (Hydrophis platurus)

Freshwater Fish
Pacific River Goby (Awaous guamensis)
Hawaiian Sleeper (ʻōʻopu akupa) (Eleotris sandwicensis)

Invertebrates - Snails & Insects
Achatinella spp.
Achatinella concavospira
Achatinella fulgens
Achintella fuscobasis
Achatinella pupukanioe
Achatinella sowerbyana
Anthricinan Yellow-Faced Bee (Hylaeus anthracinus)
Assimulans Yellow-Faced Bee (Hylaeus assimulans)
Easy Yellow-Faced Bee (Hylaeus facilis)

Achatinella bulimoides
Achatinella byronii/decepiens
Achatinella lila
Achatinella mustelina
Newcombia cumingi
Hawaiian Yellow-Faced Bee (Hylaeus longiceps)
Hilaris Yellow-Faced Bee (Hylaeus hilaris)
Hawaiian Yellow-Faced Bee (Hylaeus mana)
Hawaiian Yellow-Faced Bee (Hylaeus kuakea)
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The distribution for the Hawaiʻi Terrestrial Index is displayed below. The final rank value was determined
using a quantile distribution and was then combined with the Marine Index to create the Fish and
Wildlife Index.

Hawaiʻi Terrestrial Index Distribution
Terrestrial Index
Break Values

0-2

3-5

6-8

9 - 17

Final Rank Value

1

2

3

4

E.2 Calculating the Marine Index
In general, the same overarching methods were applied to Hawaiʻi as outlined in the Methodology and
Data Report (Dobson et al. 2020). However, due to differences in data availability, some modifications to
the datasets and methods were necessary. These are discussed in the following sections. See Appendix
A.4 for details on datasets used in this analysis. The map below shows the spatial extent of coral reefs
and the distribution of Essential Fish Habitat, Marine Protected Areas, and Habitat Areas of Particular
Concern used in the Assessment. Rankings for coral cover in Hawaiʻi are shown in the tables below,
using data collected in 2019. These distributions differ by region.
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Coral Cover
The benthic habitat maps available for Hawaiʻi were completed in 2007, and thus are potentially
unreliable given the bleaching events that have occurred since those data were collected. Therefore, to
incorporate coral cover data from NOAAʻs National Coral Reef Monitoring Program, each strata-level
(depth bin) surveyed was ranked according to the percent coral cover and then rasterized to be included
in the Marine Index (Tom Oliver, NOAA, personal communication). The strata-level depth bins were
created according to guidance from NOAA using bathymetry as follows:

Strata

Depth

Shallow

0 - 6m

Mid-depth

>6 - 18m

Deep

>18 - 30m

The percent coral cover was ranked across the islands using a natural breaks distribution and five
classes. The following ranking scheme was used to rank the coral by strata-level in Hawaiʻi. The rank
value of ‘0’ shown below is the land area of each island and benthic areas designated as “soft”.

Percent Coral Cover in Hawaiʻi

Rank Value

0

0

<= 3.10

1

<= 4.075

2

<= 8.732

3

<= 15.525

4

<= 49.48

5

Reef Fish Biomass
Reef Fish Biomass was used to further identify areas of high biodiversity. Biomass was ranked at the
sector level using a quantile distribution of the mean total fish biomass and then ranked and rasterized
into five classes to be included in the Index. The ranking scheme for Hawaiʻi is shown below. The rank
value of ‘0’ is the land area of the islands.

Reef Fish Biomass in Hawaiʻi

Rank Value

0

0

<= 18.6

1

<= 24.1

2

<= 37

3

<= 65.5

4

<= 85.6

5
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The distribution for the Marine Index is displayed below. The final rank value was determined using a
natural breaks distribution for the Index and was then combined with the Terrestrial Index to create the
Fish and Wildlife Index.

Hawaiʻi Marine Index Distribution
Marine Index Break
Values
Final Rank Value

0-2

3-5

6-8

9 - 13

1

2

3

4

E.3 Calculating the Fish and Wildlife Index
Below is the distribution for the Hawaiʻi Fish and Wildlife Index. As discussed in the Methodology and
Data Report (Dobson et al. 2020), the Terrestrial and Marine Indices were classified into four classes
before they were added together to create the Fish and Wildlife Index.

Hawaiʻi Fish and Wildlife Index Distribution
Fish & Wildlife
Index Break
Values
Final Rank Value

0-2

3

4

5

6

7-8

1

2

3

4

5

6

Using a quantile distribution, the Fish and Wildlife Index was reclassified to remain consistent with other
Regional Assessments and allows readers to distinguish values more easily.

F. Detailed Methodology: Resilience Hubs
The methodology outlined in the Methodology and Data Report (Dobson et al. 2020) for creating the
Resilience Hubs was followed for Hawaiʻi, with the following exceptions. The methodology outlined in
the Methodology and Data Report (Dobson et al. 2020) for creating the Resilience Hubs was followed for
Hawai‘i, with the following exceptions: mangroves were not considered as a designated habitat, reef
crest height was included as a designated habitat, and only coastal wetlands that are classified as tidally
influenced (both saltwater and freshwater) and regularly flooded were considered as a habitat
designation.
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G. Maps
G.1. Maps of Niʻihau and Kauaʻi
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G.2. Maps of Oʻahu
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G.3. Maps of Molokaʻi, Maui, Lānaʻi, and Kahoʻolawe
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G.4. Maps of Hawaiʻi Island
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